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About BAS-o-matic

About BAS-o-matic

BAS-o-matic is a protocol analyzer platform for Building Automation Professionals. This software
contains extensive features for monitoring and analyzing BACnet and traditional IT networks.

With BAS-o-matic you can view packet details down to the lowest layers as well as a list of
network connections, IP statistics, and bandwidth usage. Full access to raw data is also provided.
Captured packets can be saved to log files for future analysis. A flexible system of filters makes it
possible to drop packets you don't need or capture only those packets that you wish to capture.

The BAS-O-Matic also supports decoding of the BACnet MS/TP,  Modbus TCP and RTU Protocols.
These are optional decoders. Support for decoding the BACnet MS/TP and Modbus RTU requires
the U+4 hardware and works with all 32 bit operating systems. MS/TP decoder also works with
64 bit operating systems.

This application is compatible with Windows XP, Windows Vista, Windows 7 and Windows 2008
system. It works on 32 and 64 bit systems.

A complete list of IT protocols which BAS-o-matic decodes are: ARP, BCAST, BGP, BMP, CDP,
DHCP, DIAG, DNS, EIGRP, FTP, GRE, HTTP, ICMP, ICQ, IGMP, IGRP, IPsec, IPv4, IPv6, IPX, HSRP,
NCP, NDS, NetBIOS, NFS, NLSP, OSPF, POP3, PPP, PPPoE, RARP, RADIUS, RDP, RIP, RIPX, RPC,
RSVP, RTSP, SAP, SER, SMB, SMTP, SNA, SNMP, SOCKS, SPX, TCP, TELNET, TFTP, UDP, VTP, WAP,
WDOG, 802.1Q, 802.1X.

Standard BAS protocols are: BACnet / Ethernet and BACnet / IP.

What's new in v6.1

What's new in v6.1

BAS-o-matic v6.1 includes the following major improvements:

New API
Support BACnet 2008
Support for Windows Vista, Windows 7 and
Windows 2008
Works with 64 bit operating systems
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Program Install/Add/Remove/Upgrade

Program Install/Add/Remove/Upgrade

The BAS-o-matic installation file allows you to choose decoders, licensing, and Fieldbus
drivers.

Installation: Options are selected for installation by placing a checkmark in the selection
box. NOTE: You are welcome to install decoders just for DEMO purposes.

Decoders - BAS-o-matic is sold with BACnet/IP and BACnet/Ethernet decoders as standard,
and BACnet MS/TP as an option. You are given the ability to add or delete decoder files
individually. More BAS decoders are under development.  

 
Licensing - Refer to the help folder titled "Licensing / Dongle System" for a complete
explanation of these choices.  

 
Fieldbus Interface - Cimetrics makes an interface device called a "U+4" which connects an
RS485 Fieldbus network to the USB port of your computer. For MS/TP and Modbus RTU, this
requires that special driver software be loaded by the installation program. Note: for
Modbus RTU the driver ONLY compatible with 32 bit systems. You can still decode Modbus
RTU packets captured on 32 bit machines but you can not decode traffic  with U+4
hardware on 64 bit machine. If you are just looking at a demo of the MS/TP / Modbus RTU
code then you do not need to install this driver.  

Uninstall: The "installation" program can be started again to "uninstall" the entire program.

Go to Start | All Programs | Cimetrics | BAS-o-matic | Uninstall 

Add and Remove components: Run the installation program again to add or delete
decoders or drivers.

W indows XP:

Go to Start | Control Panel | Add or Remove programs | BAS-o-matic | Change Note:
In 64 bit versions Fieldbus interface field will not present an option for "Modbus RTU" driver.
Modbus RTU U+4 hardware supported only in 32 bit operating systems.

W indows Vista , W indows 8:

Go to Start | Control Panel | Programs and Features | right click on BAS-o-matic  |
Choose Change Note: In 64 bit versions Fieldbus interface field will not present an option
for "Modbus RTU" driver. Modbus RTU U+4 hardware supported only in 32 bit operating
systems.

W indows 7:

Go to Start | Control Panel | Programs | Programs and Features | right click on BAS-
o-matic  | Choose Change Note: In 64 bit versions Fieldbus interface field will not present
an option for "Modbus RTU" driver. Modbus RTU U+4 hardware supported only in 32 bit
operating systems.
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Upgrade: Purchase upgrade from Cimetrics, follow instructions on getting new keys from
Cimetrics support team. Uninstall the previous version. Install a new one and place the
software keys in BAS-o-matic folder.

Licensing / Dongle System

Licensing / Dongle System

BAS-o-matic requires a "locking mechanism" for the main program, and a "locking mechanism"
for each decoder. In order for the application to run in a licensed mode, you will need to
have both licenses in place or you will see a demo mode message. 

LOCKING MECHANISM #1:

The main BAS-o-matic program needs the following license:

BAS-o-m atic soft license  file - this is a file which is emailed to you when you purchase the
software. This is a small file (approx. 250 bytes) which is called something like "LIC12345T4.
B3L". This needs to be copied into the main BAS-o-matic folder. If you used the default
location, this is located at C:\Program Files\Cimetrics\BAS-o-matic.

LOCKING MECHANISM #2

Each protocol decoder has 2 possible licensing options (only ONE is needed):

1) Protocol Decoder soft license  file - this is a small file which is also emailed to you when
you purchase the software. Send us the "machine code" listed on the decoder popup screen
and we will create the license file and email this to you. This file is loaded into the main
BAS-o-matic folder (same location as described above). The advantage of this option is that
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there is no shipment delay or expense. The "limitation" of this is that the license will only
work on ONE computer and cannot be moved (it looks to match the "machine code" that
was supplied to us).

2) USB Dongle - this just needs to be plugged into your USB port. Use a USB hub to
connect this if you have multiple USB devices. This can be moved between computers but
requires that we physically ship this device to you (shipping expense).

UPGRADE MECHANISM 

Keep your BAS-o-matic soft license file from previous version (see LOCKING MECHANISM
#1) and install it in the BAS-o-matic folder in a new BAS-o-matic installation. 

1) If you have an existing USB Dongle after installing a new version of BAS-o-matic (make
sure you did a full removal of a previous version) plug your USB Dongle. When you start
BAS-o-matic copy the strings and email them to us. We will generate you soft licenses in
addition to your dongle. You put this soft license in the BAS-o-matic folder. This mechanism
will still allow you to move BAS-o-matic between computers - just make sure you use your
USB dongle and put a soft license to BAS-o-matic folder on a machine you want to use
BAS-o-matic.

2) If you had Protocol Decoder soft license file for previous version just remove the old
version of BAS-o-matic, reboot PC and install new version. Send us the "machine code"
listed on the decoder popus screen and we will create the license file and email this to you. 
This file is loaded into the main BAS-o-matic folder (same location as described above).

Overview

Overview

The program interface consists of five tabs that allow you to view data and perform various
actions with captured packets. To start capturing packets, select a network adapter from
the drop-down list on the toolbar, and click on the Start Capture button or select File = >
Start Capture from the menu. If network traffic passes through the selected adapter, BAS-
o-matic will start displaying information.

Main Menu

File

Suspend/Resume Packet Output – stops/resumes the real-time packet output on the 2nd

tab.
Remote Monitoring Mode – shows/hide the remote monitoring toolbar.  This is a
companion product which is not currently available.
Save Latest IP Connections As – allows you to save the contents of the Latest IP
Connections tab as a HTML or a comma-delimited (CSV) report.
Save Packet Log As – allows you to save the contents of the Packets tab in different
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formats. Use the Logging tab for advanced saving options.
Log Viewer – opens a new Log Viewer window.

Clear Latest IP Connections – clears the Latest IP Connections table (1st tab).

Clear Packet Buffer – clears the contents of the program's buffer and the packet list (2nd

tab).
Performance Data – displays the program's performance statistics: the number of packets
captured and dropped by the device driver.
Exit – closes the program.

Search
Find Packet – shows a dialog that allows you to find packets matching a specific text.
Go to Packet Number - shows a dialog that allows you to jump to a packet with the

specified number.

View
Statistics – shows a window with data transfer and protocol distribution statistics.
Port Reference – shows a window with port reference information.
Log Directory – opens the directory to which logs are saved by default.
Latest IP Connections Columns – shows/hides the Latest IP Connections tab columns.
Packets Columns – shows/hides the Packets tab columns..

Tools
Packet Generator – opens the Packet Generator window.
Reconstruct TCP Session – allows you to reconstruct a TCP session starting from the
selected packet; it opens a window that displays the entire conversation between two
hosts.
Reconstruct UDP Stream – allows you to reconstruct a UDP stream starting from the
selected packet; it opens a window that displays the entire conversation between two
hosts.
NIC Vendor Identifier – opens a window where you can identify a network adapter vendor
by MAC address.
Scheduler – allows you to add or remove scheduled capturing tasks.

Settings
Fonts – shows the submenu for setting the fonts of the interface elements.
MAC Aliases – brings up a window where you can assign easy-to-remember aliases to MAC
addresses.
IP Aliases – brings up a window where you can assign easy-to-remember aliases to IP
addresses.
Options – brings up the Options window where additional advanced program options can be
set.
Language – shows the interface language. 
Install Dial-up Driver – installs a driver for capturing packets on dial-up adapters. This
item is invisible if the driver has been installed.
Install Token Ring Driver – installs a driver for capturing packets on Token Ring adapters.
This item is invisible if the driver has been installed.

Rules
Save Current Rules As – allows you to save current rules configuration to a file.
Load Rules From – allows you to load a previously saved rules configuration from a file.
Reset All – clears all existing rules (if any).

Help
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Contents – launches BAS-o-matic help.
BACnet MS/TP – launches help on BACnet MS/TP.
Modbus/RTU – launches help on Modbus RTU.
Modbus/TCP – launches help on Modbus TCP.
BACnet/IP & B/E – launches help on BACnet/IP and BACnet/Ethernet.
About – shows information about the program.

Almost every element of the interface has a context-sensitive menu that can be invoked by
clicking on the right mouse button, and many commands are available only through these
menus.
 
The first tab is used for displaying detailed information about your computer's network
connections (IP protocol only). For more information see Latest IP Connections.
 
The second tab is used for viewing captured network packets and displaying detailed
information about a selected packet. For more information see Packets.
 
The third tab allows you to save captured packets to files. For more information see 
Logging.
 
The fourth tab is for configuring rules that allow you to capture/ignore packets based on
various criteria, such as IP address or port number. For more information see Filters &
Rules.
 
The fifth tab allows you to create alarms that can notify you about important events, such
as suspicious packets, high bandwidth utilization, unknown addresses, etc. For more
information see Alarms.

You can change some of the settings, such as fonts, colors, and buffer size by selecting 
Settings from the menu. For more information see Setting Options.

Latest IP Connections

Latest IP Connections

This tab is used for displaying detailed information about your computer's network
connections (IP and IPv6 protocols only). To start capturing packets, select File = > Start
Capture in the menu, or click on the corresponding button on the toolbar.
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The meaning of the table columns is explained below:
 
Local IP – shows the local IP address. For inbound packets, it is the destination IP address;

for outbound and pass-through packets, it is the source IP address.
Remote IP – shows the remote IP address. For inbound packets, it is the source IP

address; for outbound and pass-through packets, it is the destination IP address.
 
The program automatically determines the location of any IP address, and depending on

your geolocation settings, may show the country name or flag next to the IP address. For
more information see Setting Options.

 
In – shows the number of packets received.
Out – shows the number of packets sent.
Direction – shows the session direction. The direction is determined based on the direction

of the first packet received from or sent to the remote IP address.
Sessions – shows the number of established TCP/IP sessions. If no TCP connections were

established (connections failed, or the protocol is UDP/IP or ICMP/IP), this value is zero.
Ports – lists the remote computer's ports used during the TCP/IP connection or connection

attempt. This list can be empty if the protocol is not TCP/IP. Ports can be displayed either
as numeric values or as the corresponding service names. For more information see 
Setting Options.

Hostname – shows the remote computer's hostname. If the hostname cannot be resolved,
this column is empty.

Bytes – shows the number of bytes transmitted during the session.
Process – shows the process on your computer that sends or receives packets in the
session. Mapping packets to processes only works for incoming and outgoing packets, as
BAS-o-matic cannot be aware of processes running on other computers that send or receive
packets. Naturally, there may be several applications on the local computer exchanging data
with a remote computer, so the Latest IP Connections tab only shows the latest process
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that sent or received data for this particular pair of IP addresses. If you would like to map a
process to a particular packet, you can see this information in the decoded packet tree in
the Packets tab. BAS-o-matic can display the full path to the process that sent or received
packets, check the Display full process path checkbox in Settings => Options, General
tab to enable this feature. When working in remote monitoring mode through Remote
Agents, this column displays the IP address or the hostname of the Remote Agent from
which the packets are being received; no process names will available. Please note that on
some operating systems, this column will list process names only after you reboot the
computer after the BAS-o-matic installation.
 
You can show or hide individual columns by right-clicking on list header or using the View

=> Latest IP Connections Columns menu. The column order can be changed by dragging
the column header to a new location.

 
 
Menu Commands
 
Right-clicking on the Latest IP Connections list brings up a menu with the following

commands:
 
Quick Filter – finds the packets sent between the selected IP addresses and displays them

in a new window. The same action is performed when you double-click on this window.
Copy – copies the local IP address, remote IP address, or hostname to the clipboard.
Show All Ports – displays a window with the complete list of ports used in communicating

between the selected pair of IP addresses. This is useful when many ports were used, and
they don't fit into the corresponding column.

Data Transfer – displays a window with information on the data transfer volume between
the selected pair of IP addresses and the time of the last packet.

Jump To – allows you to quickly jump to the first/last packet with the selected source/
destination IP address; the program will display the Packets tab and set the mouse cursor
to the packet that matches the criterion.

SmartWhois – sends the selected source or destination IP address to SmartWhois, if it is
installed on your system. SmartWhois is a stand-alone application developed by Tomasoft
capable of obtaining information about any IP address or hostname in the world. It
automatically provides information associated with an IP address, such as domain, network
name, country, state or province, city. The program can be downloaded from our Tomasoft
web site.

Create Alias -- brings up a window where you can assign an easy-to-remember aliases to
the selected IP address.

Process – allows you to obtain additional information about or perform actions with the
process that sends or receives packets in the selected session. You can Terminate a
process, see the File Properties dialog, or have the program Show Full Path to process'
executable file.

Save Latest IP Connections As – allows you to save the contents of the Latest IP
Connections tab as an HTML or a comma-delimited (CSV) report.

Clear Latest IP Connections – clears the table.
More Statistics  - shows a window with data transfer and protocol distribution

statistics.

Packets

Packets

This tab is used for listing all captured network packets and displaying detailed information about
a selected packet.
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The top table displays the list of captured packets. Use this list for selecting a packet that
you want to have displayed and analyzed. When you select a packet by clicking on it, other
panes show information about the selected packet.
 
The meaning of the table columns is explained below:
 
No – a unique packet number.
Protocol – shows the packet's protocol.
Src MAC, Dest MAC – shows the source and destination MAC addresses.
Src IP, Dest IP – shows the source and destination IP addresses (where applicable).
Src Port, Dest Port – shows the source and destination ports (where applicable). Ports can

be displayed either as numeric values or as the corresponding service names. For more
information, see Setting Options.

Time / Delta – shows the packet's absolute or delta time. Delta time is the difference
between the absolute times of the last two packets. You can switch from absolute to
delta time by clicking View =>Packets Columns =>Show Time As.

Size – shows packet size in bytes. This column is not visible by default.
 
You can show or hide individual columns by right-clicking on list header or using the View

=> Packets Columns menu. The column order can be changed by dragging the column
header to a new location.

 
The packet output can be suspended by clicking File =>Suspend Packet Output. In the

Suspended mode, the packets are being captured, but not displayed, on the Packets tab.
This mode is useful when you are interested only in the statistics rather than individual
packets. To resume real-time packets display, click File =>Resume Packet Output.

 
The middle pane displays the raw contents of the packet, both in hexadecimal notation

and as plain text. In the plain text, non-printable characters are replaced with dots. When
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multiple packets are selected in the top table, the middle pane displays the total number
of selected packets, the total size, and the time span between the first and the last
packet.

 
The bottom pane displays decoded packet information for the selected packet. This

information includes vital data that can be used by network professionals. Right-clicking on
the pane invokes the context menu that allows you to collapse/expand all the nodes or to
copy the selected or all nodes.

 
The packets tab also includes a small toolbar shown below:
 

 
You can change the position of the decoder window by clicking on one of the three buttons

on this toolbar (you can have a bottom-, left-, or right-aligned decoder window).  The
fourth button makes the packet list auto-scroll to the last packet received. The fifth
button keeps the packet you selected in the list visible (i.e. it won't leave the visible area
as new packets arrive). The sixth button allows you to open the contents of the current
packet buffer in a new window. This functionality is very useful under a heavy network
load, when the packet list is rapidly scrolling and it's difficult to examine packets before
they move out of the visible area. Clicking on this button creates a snapshot of the buffer
so you can comfortably examine it in a separate window. You can make as many
snapshots as you wish.

 
 
Menu Commands
 
Right-clicking on the packet list brings up a menu with the following commands:
 
Reconstruct TCP Session – allows you to reconstruct a TCP session starting from the

selected packet; it opens a window that displays the entire conversation between two
hosts. The same action is performed when you double-click on this window.

Quick Filter – finds the packets sent between the selected MAC addresses, IP addresses,
or ports and displays them in a new window.

Open Packet(s) in New Window – allows you to open one or several selected packets in a
new window for comfortable examination.

Create Alias -- brings up a window where you can assign an easy-to-remember aliases to
the selected MAC or IP address.

Copy Address – copies the source MAC address, destination MAC address, source IP
address, or destination IP address to the clipboard.

Copy Packet – copies the raw data of the selected packet to the clipboard.
Send Packet(s) – shows the Packet Generator window that allows you to resend the

selected packet or a group of packets. You can also modify the packet contents before
sending it.

Save Packet(s) As – saves the contents of the selected packet(s) to a file. The Save As
dialog allows you to select the format to be used when saving data from the drop-down
list.

SmartWhois – sends the source or destination IP address from the selected packet to
SmartWhois if it is installed on your system. SmartWhois is a stand-alone application
developed by company called TamoSoft capable of obtaining information about any IP
address or hostname in the world. It automatically provides information associated with an
IP address, such as domain, network name, country, state or province, and city. The
program can be downloaded from TamoSoft site.

Clear Packet Buffer – clears the contents of the program's buffer. The packet list will be
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cleared, and you will not be able to view the packets previously captured by the program.
Decode As – for TCP and UDP packets, allows you to decode supported protocols that use

non-standard ports.  For example, if your SOCKS server runs on port 333 rather than 1080,
you can select a packet that belongs to the SOCKS session and use this menu command
to make BAS-o-matic decode all packets on port 333 as SOCKS packets. Such protocol-
port reassignments are not permanent and will last only until the program is closed. Note
that you cannot override standard protocol-port pairs, e.g. you cannot make BAS-o-matic
decode packets on port 80 as TELNET packets.

Font – allows you to increase or decrease the font size used to display packets without
affecting the font size of all other interface elements.

 
You can also drag-and-drop selected packet(s) to the desktop.

Logging

Logging

This tab is used for saving captured packets to a file on the disk. BAS-o-matic saves
packets in its own format with the .NCF extension. The old (.CCF) format is supported for
backward compatibility; however, you can no longer save the captured packets.  You can
open and view these files at any time using Log Viewer, or you can just double-click on
any NCF or CCF file to have it loaded and decoded.

 
NCF is an open format; please refer to BAS-o-matic Log Files Format chapter for detailed

NCF format description.
 
Save and Manage
 
Use this frame to save the captured packets manually to a file and to concatenate/split

capture files.
 
It is possible either to save all packets currently stored in the buffer or save only a part of

them within a given range. The To and From fields allow you to set the necessary range
based on the packet numbers as shown on the Packets tab. Click Save As … to select a
file name.

 
To concatenate manually multiple NCF files into a single, larger file, click on the 

Concatenate Logs button. To split NCF files that are too large in size into smaller chunks,
click on the Split Logs button. Then the program will guide you through the process, and
you will be able to enter the desired size of the output files.

 
Auto-saving
 
Check this box to have the program automatically save captured packets as they arrive.

Use the Maximum directory size field to limit the total size of the capture files stored in
the Log Directory. If the total size of the capture files exceeds the limit, the program
automatically deletes the oldest files in the directory. The Average Log File Size field
allows you to specify the approximate desired size of each log file. When the log file
reaches the specified size, a new file is automatically created. To change the default Log
Directory, click on the Save files to box and select a different folder.

 
IMPORTANT: If you want to have an important capture file stored for a long time, don't keep

it in the default Log Directory: there is a chance it will be automatically deleted as new
files are being saved. Move the file to a different folder to preserve it.

 
Please note that the program doesn't save each packet individually immediately upon arrival.
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It means that if you view the log file in real time, it may not contain the latest packets. To
make the program immediately dump the buffer to the log file, click Stop Capture or
uncheck the Auto-saving box.

 
WWW Access Logging
 
Check this box to enable logging of HTTP sessions. Use the Maximum file size field to limit

the size of the log file. If the log file size exceeds the limit, the program automatically
deletes the oldest records in the file. To change the default file name and path, click on
the Save files to box and select a different file name. Log files can be generated in HTML
or TXT formats. Click Configure to change the default logging options. You can change
the port number that is used for HTTP access (the default value of 80 might not work for
you if you are behind a proxy server), and exclude certain data types (usually logging
anything other than HTML pages is quite useless, therefore it is a good idea to exclude
URLs of pictures from the log file).

Viewing Logs

Viewing Logs

Log Viewer is a tool for viewing and exploring capture files created by BAS-o-matic and
several other packet analyzers. It has the functionality of the Packets tab of the main
program window, but unlike the Packets tab, Log Viewer displays packets loaded from the
files on the disk rather than the packets captured in real time.
 
To open Log Viewer, click File => Log Viewer in the program's main menu, or just double-
click on any BAS-o-matic capture file that you have previously saved. You can open as
many Log Viewer windows as you wish, and each of them can be used for exploring one or
several capture files.
 
Log Viewer can be used for exploring capture files created by other packet analyzers and
personal firewalls. The current version can import files in the Network Instruments
Observer®, Network General Sniffer® for DOS/Windows, Microsoft® NetMon, WildPackets
EtherPeek™ and AiroPeek™, and Tcpdump (libcap) formats. These formats are also used by

a number of 3rd-party applications. Log Viewer is capable of exporting packet data by
creating files in the Network Instruments Observer®, Network General Sniffer® for DOS/
Windows, Microsoft® NetMon, WildPackets EtherPeek™ and AiroPeek™, and Tcpdump
(libcap) formats, as well as the native BAS-o-matic format.
 
Using Log Viewer is similar to using the Packets tab of the main window; please refer to
the Packets chapter if you need detailed information.
 

Log Viewer Menu
 

File
Load BAS-o-matic Logs – opens and loads one or several BAS-o-matic capture files.
Import Logs – allows you to import capture files created by other packet analyzers.
Export Logs – allows you to export the displayed packets to capture files in several
formats.
Clear Window – clears the packet list.
Generate Statistics – makes BAS-o-matic generate statistics on the packets loaded in Log
Viewer. Optionally, it is possible to reset previously collected statistical data displayed in
the Statistics window. Please note that this function will not show packet distribution along
the timeline. It is limited to displaying totals, protocol charts, and LAN hosts tables.
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Close Window – closes the window.
 

Search
Find Packet – shows a dialog that allows you to find packets matching a specific text.
Go to Packet Number - shows a dialog that allows you to jump to a packet with the
specified number.
 

Rules
Apply – applies your current rule set to the packets displayed in Log Viewer. As a result,
when you use this command the program will delete the packets that don't match the
current rule set. Note that this won't modify the file on the disk.
From File … - does the same as the Apply command, but allows you to use a rule set from
a previously saved .RLS file rather than the current rule set.

Log File Format

Log File Format

BAS-o-matic uses the data format described below for writing captured packets to .NCF
files. This is an open data format that you can use for processing log files generated by
BAS-o-matic in your applications, as well as for exchanging data with your application
directly (this method is described in this help file).

The packets are recorded consecutively. A 24-byte header, the structure of which is given
below, prepends each packet body. All header fields with the length exceeding 1 byte use
little-endian byte order.

Field name
Length
(bytes)

Description

Data Length 2 The length of the packet body that follows the
header

Source Data Length 2 The original length of the packet body that
follows the header (without compression). If no
compression is being used, the value of this field
is equal to the value of the previous field.

Version 1 Packet format version (0 for the current
implementation)

Year 2 Packet date (year)

Month 1 Packet date (month)

Day 1 Packet date (day)

Hours 1 Packet time (hours)

Minutes 1 Packet time (minutes)

Seconds 1 Packet time (seconds)

Microseconds 4 Packet time (microseconds)

Flags 1 Bit flags:
 

Medium 0...3 Medium type
for the packet
(0 - Ethernet,
1 - WiFi, 2 -
Token Ring)

Decrypted 4 The packet
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has been
decrypted
(applicable to
WiFi packets
only)

Broken 5 The packet
was
corrupted, i.e.
had the
incorrect CRC
value
(applicable to
WiFi packets
only)

Compressed 6 The packet is
stored in
compressed
form

Reserved 7 Reserved

Signal Level 1 Signal level in percents (applicable to WiFi packets
only)

Rate 1 Date transmission rate in Mbps multiplied by 2
(applicable to WiFi packets only)

Band 1 Transmission band. 0x01 for 802.11a, 0x02 for
802.11b, 0x04 for 802.11g, 0x08 for 802.11a-
turbo, 0x10 for 802.11 SuperG. (applicable to
WiFi packets only)

Channel 1 Channel number (applicable to WiFi packets only)

Direction 1 Packet direction. 0x00 for pass-through, 0x01 for
inbound, 0x02 for outbound (not applicable to
WiFi packets)

Reserved 2 Reserved

Data ... Packet body (unmodified, as transmitted over the
media). If the compression flag is set, the data is
compressed using the publicly available Zlib 1.1.4
library. The length of this field is recorded in Data
Length.

The total header length is 24 bytes. If packets are stored in the compressed form, the Data
Length field contains the length of data after compression, whilst the Source Length field
contains the original data length. If a packet is uncompressed, both fields contain the same
value.

Filters & Rules

Filters & Rules

This tab allows you to set rules for capturing packets. If one or more rules are set, the
program filters packets based on these rules and displays only the packets that comply with
the rules. Note that BAS-o-matic is not a firewall, and when you set rules, packets are still
processed by the operating system; they are not just displayed and logged by BAS-o-matic.
If a rule is set, the name of the corresponding tab is displayed in bold font.
 
You can save your rules configuration(s) to a file and load them by using the Rules
command of the program's menu.
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Since LAN traffic can often generate a high number of packets, it is recommended that you
use rules to filter out unnecessary packets. This can considerably reduce the amount of
system resources consumed by the program. If you want to enable/disable a rule, select the
appropriate branch on the left side of the window (e.g. IP Addresses or Ports), and check
or uncheck the box describing the rule (Enable IP Address rules or Enable port rules).
There are eight types of rules that can be used:
 
 
Protocols & Direction
 
Allows you to ignore or capture packets based on Ethernet (Layer 2) and IP (Layer 3)
protocols, as well as on packet direction.
 

 
This example shows how to make the program capture only inbound and outbound ICMP and
UDP packets. All other packets in the IP family will be ignored; all pass-through packets will
be ignored also.
 
 
MAC Addresses
 
Allows you to ignore or capture packets based on MAC (hardware) addresses. Enter a MAC
address in the Add Record frame, select the direction (From, To, or Both), and click Add
MAC Address. The new rule will be displayed. Now you can select the action to be taken
when a new packet is processed: the packet can be either captured or ignored. You can
also click on the MAC Aliases button to get the list of aliases; double-click on the alias you
would like to add, and the corresponding MAC address will appear in the input box.
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This example shows how to make the program ignore packets that come from 0A:
DE:34:0F:23:3E. All packets that come from other MAC addresses will be captured.
 
 
IP Addresses
 
Allows you to ignore or capture packets based on IP addresses. Enter an IP or IPv6 address
in the Add Record frame, select the direction (From, To, or Both), and click Add IP
Address. You can use wildcards to specify blocks of IP addresses. The new rule will be
displayed. Now you can select the action to be taken when a new packet is processed: the
packet can be either captured or ignored. You can also click on the IP Aliases button to
access the list of aliases; double-click on the alias you would like to add, and the
corresponding IP address will appear in the input box.
  

 
This example shows how to make the program capture the packets that go to 63.34.55.66,
go to and come from 207.25.16.11 and come from all addresses between 194.154.0.0 and
194.154.255.255. All packets that come from other addresses or go to other addresses will
be ignored. Since IP addresses are used in the IP protocol, such configuration will
automatically make the program ignore all non-IP packets. Usage of IPv6 addresses requires
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Windows XP or higher and that the IPv6 stack be installed.
 
 
 
Ports
 
Allows you to ignore or capture packets based on ports. Enter a port number in the Add
Record frame, select the direction (From, To, or Both), and click Add Port. The new rule
will be displayed. Now you can select the action to be taken when a new packet is
processed: the packet can be either captured or ignored. You can also click on the Port
Reference button to get a list of all known ports; double-click on the port you would like to
add and its number will appear in the input box. Ports can also be entered as text; for
example, you can type in ht tp or pop3, and the program will convert the port name to the
numeric value.
 

 
This example shows how to make the program ignore packets that come from port 80 and go
to and come from port 137. This rule will prevent BAS-o-matic from displaying inbound HTTP
traffic, as well as inbound and outbound NetBIOS Name Service traffic. All packets coming
to and from other ports will be captured.
 
 
TCP Flags
 
Allows you to ignore or capture packets based on TCP flags. Check a flag or a combination
of flags in the Add Record frame, and click Add Flags. The new rule will be displayed. Now
you can select the action to be taken when a new packet with the entered TCP flags  is
processed: the packet can be either captured or ignored.
 



18 Chapter 2 Using BAS-o-matic features

2Using BAS-o-matic features

 
This example shows how to make the program ignore TCP packets with the PSH ACK flag. All
packets with other TCP flags will be captured.
 
 
Text
 
Allows you to capture packets that contain certain text. Enter a text string in the Add
Record frame, select the type of entered information  (As String or As Hex), and click Add
Text. The new rule will be displayed. You can enter text either as a string (self-
explanatory), or as a hexadecimal value. The latter method should be used when you want
to enter non-printable characters: just type hexadecimal character values separated by
spaces, as shown below. Now you can select the action to be taken when a new packet is
processed: the packet can be either captured or ignored.
 

 
This example shows how to make the program capture only the packets that contain either
"GET" or the 01 02 03 04 hex data. Check the Case sensitive box if you want the rules to
be case sensitive. All other packets that do not contain the text mentioned above will be
ignored.
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Process
 
Allows you to capture packets based on the process name. Enter a process name in the 
Add Record frame and click Add Process Name. The new rule will be displayed. Now you
can select the action to be taken when a new packet is processed: the packet can be
either captured or ignored. You can enter partial process names, e.g. netsc p or net; any
process name that contains such a substring will match the rule. Process names are not
case-sensitive.
 

 
This example shows how to make the program capture only the packets that were sent or
received by netsc p.exe. Packets sent by other processes will be ignored.
 
Advanced
 
Advanced rules are the most powerful and flexible rules that allow you to create complex
filters using Boolean logic. For the detailed help on using advanced rules, please refer to
the Advanced Rules chapter.

Advanced Rules

Advanced Rules

Advanced rules are the most powerful and flexible rules that allow you to create complex
filters using Boolean logic. Using advanced rules requires a basic understanding of
mathematics and logic, but the rules syntax is rather easy to understand.
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Overview
 
To add a new rule, you should enter an arbitrary name in the Name field, select the action
(Capture/Ignore), enter a Formula using the syntax described below, and click Add/Edit
. Your new rule will be added to the list and become active immediately. You can add as
many rules as you wish, but only those rules that have a checked box next to the rule name
are active currently. You can activate/deactivate rules by checking/unchecking the
corresponding boxes or completely delete selected rules using the Delete button. If more
than one rule is active, you can evaluate the resulting combined rule by clicking Evaluate.
Please note that multiple active rules are combined using the logical OR operator, e.g. if you
have three active rules, RULE1, RULE2, and RULE3, the resulting rule is RULE1 OR RULE2 OR
RULE3.
 
You can use advanced rules in conjunction with the basic rules described in the previous
chapter, however if you feel comfortable with Boolean logic, it's a good idea to use
advanced rules only, as they offer much more flexibility. Basic rules are combined with
advanced rules using the logical AND operator.
 
Syntax Description
 
dir – Packet direction. Possible values are in (inbound), out (outbound), and pass (pass-
through).
 
etherproto – Ethernet protocol, the 13th and 14th bytes of the packet. Acceptable values
are numbers (e.g. etherproto=0x0800 for IP) or common aliases (e.g. etherproto=ARP,
which is equivalent to 0x0806).
 
ipproto – IP protocol. Acceptable values are numbers (e.g. ipproto!=0x06 for TCP) or
commonly used aliases (e.g. ipproto=UDP, which is equivalent to 0x11).
 
smac – Source MAC address. Acceptable values are MAC addresses in hex notation (e.g.
sm ac =00:00:21:0A:13:0F) or user-defined aliases.
 
dmac – Destination MAC address.
 
sip – Source IP or IPv6 address. Acceptable values are IP addresses in dotted notation (e.
g. sip=192.168.0.1 or sip= fe80::02c 0:26ff:fe2d:edb5), IP addresses with wildcards (e.g.
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sip!=*.*.*.255, except for IPv6 addresses),  network addresses with subnet masks (e.g.
sip=192.168.0.4/255.255.255.240 or sip=192.168.0.5/28), IP ranges (e.g. sip from
192.168.0.15 to 192.168.0.18 or sip in 192.168.0.15 .. 192.168.0.18 ), or  user-defined
aliases. Use of IPv6 addresses requires Windows XP or higher and that the IPv6 stack be
installed.
 
dip -  Destination IP address.
 
sport – Source port for TCP and UDP packets. Acceptable values are numbers (e.g.
sport=80 for HTTP), ranges (e.g. sport  from  20 to 50  or sport  in 20..50 for any port
number between 20 and 50) or the aliases defined by your operating system  (e.g. 
sport=ftp, which is equivalent to 21). For the list of aliases supported by your OS click
View => Port Reference.
 
dport – Destination port for TCP and UDP packets.
 
flag – TCP flag.  Acceptable values are numbers (e.g. 0x18 for PSH ACK) or one or several
of the following characters: F (FIN), S (SYN), R (RST), P (PSH), A (ACK), and U (URG), or
the has keyword, which means that the flag contains a certain value. Usage examples:
flag=0x18, flag=SA, flag has F.
 
size – Packet size. Acceptable values are numbers (e.g. size=1514) or ranges (e.g. size
from  64 to 84 or size in 64..84 for any size between 64 and 84).
 
str – Packet contents. Use this function to indicate that the packet must contain a certain
string. This function has three arguments: string, position, and case sensitivity. The first
argument is a string, e.g. 'GET '. The second argument is a number that indicates the string
position (offset) in the packet. The offset is zero-based, i.e. if you're looking for the first
byte in the packet, the offset value must be 0. If the offset is not important, use 1. The
third argument indicates the case-sensitivity and can be either fa lse (case-insensitive) or
t rue (case-sensitive). The second and third arguments are optional; if omitted, the offset
defaults to 1 and the case-sensitivity defaults to fa lse. Usage examples: st r('GET ',-1,fa lse)
, st r('GET ',-1), st r ('GET ').
 
hex - Packet contents. Use this function to indicate that the packet must contain a certain
hexadecimal byte pattern. This function has two arguments: hex pattern and position. The
first argument is a hex value, e.g. 0x4500. The second argument is a number that indicates
the pattern position (offset) in the packet. The offset is zero-based, i.e. if you're looking for
the first byte in the packet, the offset value must be 0. If the offset is not important, use 
1. The second argument is optional; if omitted, the offset defaults to 1. Usage examples:
hex(0x04500, 14) , hex(0x4500, 0x0E), hex (0x010101).
 
bit - Packet contents. Use this function to determine if the specified bit at the specified
offset is set to 1, in which case the function returns t rue. If the specified bit is set to 0 or
the specified byte is beyond the packet boundary, the function returns fa lse. This function
has two arguments: bit index and byte position. The first argument is the bit index in the
byte; the allowed values are 0-7. The index is zero-based, i.e. if you're looking for the
eighth bit in the byte, the index value must be 7. The second argument is a number that
indicates the byte position (offset) in the packet. The offset is zero-based, i.e. if you're
looking for the first byte in the packet, the offset value must be 0. Both arguments are
mandatory. Usage examples: bit (0, 14) , bit (5, 1).
 
The keywords described above can be used with the following operators:
 
and - Boolean conjunction.
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or - Boolean disjunction.                                
not - Boolean negation.                
=  - Arithmetic equality.
!= - Arithmetic inequality.
<> - Same as above.
> - Arithmetic greater-than.
< - Arithmetic less-than.
( ) – parenthesis, control operator precedence rules.
 
All numbers can be in decimal or hexadecimal notation. If you want to use the hexadecimal
notation, the number must be preceded by 0x, i.e. you can use either 15 or 0x0F.
 
Examples
 
Below you will find a number of examples illustrating the rules syntax. Each rule is followed
by our comments about what the rule does.The rules are shown in red. The comments are
separated from the actual rule by two slashes.

 
dir!=pass // Captures only inbound and outbound packets. Pass-through
packets being sent between other workstations on the LAN are ignored.
(smac=00:00:21:0A:13:0E or smac=00:00:21:0A:13:0F) and etherproto
=arp // Captures ARP packets sent by two computers, 00:00:21:0A:13:0E
and 00:00:21:0A:13:0F.
ipproto=udp and dport=137 // Captures UDP/IP packets sent to the port
number 137.
dport=25 and str('RCPT TO:', -1, true) // Captures TCP/IP or UDP/IP
packets that contain "'RCPT TO:" and where the destination port is 25.
not (sport>110) // Captures everything except the packets where the
source port is greater than 110.
(sip=192.168.0.3 and dip=192.168.0.15) or (sip=192.168.0.15 and dip
=192.168.0.3) // Captures only the IP packets being sent between two
machines, 192.168.0.3 and 192.168.0.15. All other packets are discarded.
((sip from 192.168.0.3 to 192.168.0.7) and (dip = 192.168.1.0/28))
and (flag=PA) and (size in 200..600) // Captures TCP packets the size of
which is between 200 and 600 bytes coming form the IP addresses in the
192.168.0.3 - 192.168.0.7 range, where destination IP address is in the
192.168.1.0/255.255.255.240 segment, and where the TCP flag is PSH ACK.
Hex(0x0203, 89) and (dir<>in) // Captures the packets that contain
0x0203 at the offset 89, where the packet direction is not inbound.

 

Alarms

Alarms

This tab allows you to create alarms that can notify you about important events, such as
suspicious packets, high bandwidth utilization, unknown addresses, etc. Alarms are very
useful in a situation were you need to watch the network for some suspicious events, for
example distinctive byte patterns in captured packets, port scans, or unexpected hardware
device connections.
 
Alarms are managed using the alarm list shown below:
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Each line represents a separate alarm, and the check box next to the alarm name indicates
if the alarm is currently active. When an alarm is triggered, the check mark disappears. To
reactivate a deactivated alarm, check the box next to its name. To disable all alarms,
uncheck the Enable alarms box. To add a new alarm or edit or delete an existing one, use
the buttons to the right of the alarm list. The E-mail Setup button should be used for
entering information about your SMTP server if you plan to use e-mail notification options
(see below).
 
The alarm setup window is shown below:
 

 
The Name field should be used for describing the alarm function. Check the Enabled box if
you want the alarm that you're adding/editing to be activated once you've finished its
setup. This check box is equivalent to the one shown in the alarms list. The Alarm Type
frame allows you to select one of the seven alarm types:
 

Packet occurrence: The alarm will be triggered once BAS-o-matic has captured a
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packet that matches the given formula. The formula syntax is the same as the
syntax used in Advanced Rules and is described in the Advanced Rules
chapter in detail.

 
Bytes per second: The alarm will be triggered once the number of bytes per

second has exceeded (or fallen below) the specified value. Note that you
should enter the value in bytes, so if you would like to have the alarm
triggered when the data transfer rate exceeds 1Mbyte per second, the value
you should enter is 1000000.

 
Packets per second: The alarm will be triggered once the number of packets per

second has exceeded (or fallen below) the specified value.
 

Broadcasts per second: The alarm will be triggered once the number of
broadcast packets has exceeded (or fallen below) the specified value.

 
Multicasts per second: The alarm will be triggered once the number of multicast

packets has exceeded (or fallen below) the specified value.
 

Unknown MAC address: The alarm will be triggered once BAS-o-matic has
captured a packet with an unknown source or destination MAC address. Use
the Configure button to enter known MAC addresses. This alarm type is useful
for detecting new, unauthorized hardware devices connected to your LAN.

 
Unknown IP address: The alarm will be triggered once BAS-o-matic has captured

a packet with an unknown source or destination IP or IPv6 address. Use the 
Configure button to enter known IP addresses. This alarm type is useful for
detecting unauthorized IP connections behind a corporate firewall. Use of IPv6
addresses requires Windows XP or higher and that the IPv6 stack be installed.

 
The Events needed to trigger field allows you to specify the number of times the expected
event must occur before the alarm is triggered. For example, if you specify the value of 3,
the alarm will not be triggered until the even occurs three times. If you edit an existing
alarm, the internal event counter will be reset.
 
The Times to trigger this alarm field allows you to specify the number of times your alarm
may be triggered before the deactivation. By default, this value equals 1, so the alarm will
be disabled after the first even occurrence. By increasing this value, you will make BAS-o-
matic trigger the alarm multiple times.  If you edit an existing alarm, the internal trigger
counter will be reset.
 
The Action frame allows you to select the actions to be performed when the alarm event
occurs. The following actions are available:
 

Display message: Shows a non-modal message box with the specified text.
This action allows use of variables that are to be replaced by the
corresponding parameters of the packet that has triggered the alarm. These
variables are listed below:

%SMAC% -- source MAC address.
%DMAC% -- destination MAC address.
%SIP% -- source IP address.
%DIP% -- destination IP address.
%SPORT% -- source port.
%DPORT% -- destination port.
%ETHERPROTO% -- Ethernet protocol.
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%IPPROTO% -- IP protocol.
%SIZE% -- packet size.
%FILE% -- the path to a temporary file that contains the captured packet.
 
For example, if your message is "SYN packet received from %SIP%", in the actual pop-up

window text %SIP% will be replaced by the source IP address of the packet that
triggered the alarm. If you use the %FILE% variable, a .NCF file will be created in the
temporary folder. It is your responsibility to delete the file after it has been processed;
BAS-o-matic makes no attempt to delete it. You should not use variables if the alarm is
triggered by Bytes per second or Packets per second values, as these alarm types
are not triggered by individual packets.

 
Pronounce message: Makes Windows speak the specified text using the text-

to-speech engine. This box is disabled if your Windows version doesn't have
the text-to-speech engine. By default, Windows only comes with English
computer voices, so Windows may not be able to pronounce messages
correctly if the text is entered in a language other than English. You can use
the variables described in the Display message section in the message text.

 
Play sound: Plays the specified WAV file.

 
Launch application: Runs the specified EXE or COM file. Use the optional

Parameters field to enter command line parameters. You can use the
variables described in the Display message section above as the command
line parameters if you want your application to receive and process information
about the packet that triggered the alarm.

 
Send e-mail to: Sends e-mail to the specified e-mail address. You MUST

configure BAS-o-matic to use your SMTP server prior to sending e-mail. Use
the E-mail Setup button next to the alarm list to enter your SMTP server
settings and send a test e-mail message. Usually, an e-mail message can also
be used to send alerts to your instant messaging application, cell phone, or
pager. For example, to send a message to an ICQ user, you should enter the
e-mail address as ICQ_USER_UIN@pager.icq.com, where ICQ_USER_UIN is the
user's unique ICQ identification number, and allow EmailExpress messages in
the ICQ options. Please refer to your instant messenger documentation or cell
phone operator for more information. The Add text field can be used to add an
arbitrary message to the e-mail notification. You can use the variables
described in the Display message section in the message text.

 
Enable capturing rules: Enables Advanced Rules; you should enter the rule

name(s). If multiple rules must be enabled, separate them with a comma or
semicolon.

 
Disable other alarms: Disables other alarms; you should enter the alarm name

(s). If multiple alarms must be enabled, separate them with a comma or
semicolon.

 
Start logging: Turns on auto-saving (see the Logging chapter); BAS-o-matic

will start dumping packets to the hard drive.
 

Stop logging: Turns off auto-saving.
 

 
Click OK to save the settings and close the alarm setup dialog.
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All the events and actions related to the alarms will be listed in the Event Log window
below the alarm list.

Reconstructing TCP Sessions

Reconstructing TCP Sessions

This tool allows you to view the TCP conversation between two hosts.  To reconstruct a
TCP session, you should first select a TCP packet on the Packets tab. Depending on the
settings (the Search for the session start when reconstructing TCP sessions box in
Settings => Options => Decoding), the session will be reconstructed from the selected
packet that may be in the middle of the "conversation" or from the session start. If you
want to reconstruct the entire session, it is recommended that you select the first packet
in the session; otherwise, the reconstruction may start in the middle of the "conversation".
After you locate and select the packet, go to  select Reconstruct TCP Session from the
pop-up menu as shown below:
 

 
Reconstructing sessions works best for text-based protocols, such as POP3, Telnet, or
HTTP. Of course, you can also reconstruct a download of a large zipped file, but it can take
BAS-o-matic a long time to reconstruct several megabytes of data, and the obtained
information would be useless in most of the cases. The Contents tab displays the actual
session data, while the Session Analysis tab graphically displays the flow of the
reconstructed TCP session. A sample HTTP session that contains HTML data displayed in
ASCII and HTML modes is shown below:
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In HTML display mode, HTML pages never include inline graphics, because in HTTP protocol
images are transferred separately from HTML data. To view the images, usually it is
necessary to navigate to the next TCP session. A sample HTTP session that contains image
data displayed in HTML mode is shown below:
 



28 Chapter 2 Using BAS-o-matic features

2Using BAS-o-matic features

 
By default, BAS-o-matic attempts to decompress GZIP'd web content and reconstruct
images from binary streams. If you want to turn off this functionality, use the Decoding
tab of the program's Options dialog.
 
You can filter out the data that came from one of the directions by unchecking one of the
check boxes on the bottom pane. Incoming and outgoing data are marked by different
colors for your convenience. If you want to change one of the colors, click Settings =>
Colors and pick a different color. You can enable or disable word wrapping using the Word
Wrap item in the Settings menu.
 
The Display type drop-down list allows you to view data in the ASCII (plain-text data),
HEX (hexadecimal data), HTML (web pages and images), EBCDIC (IBM mainframes' data
encoding), and UTF-8 (Unicode data) formats. Please note that viewing data as HTML does
not necessarily produce exactly the same result as the one you can see in the web browser
(e.g. you will not be able to see inline graphics); however, it should give you a good idea of
what the original page looked like.
 
You can choose the default display type for the TCP Session Reconstruction window in the 
Decoding tab of the program's Options dialog.
 
The Navigation buttons allow you to search the buffer for the next or previous TCP
session. The first forward button (>>) will search for the next session between those two
hosts that were involved in the first reconstructed session. The second forward button
(>>>) will search for the next session between any two hosts. If you have multiple TCP
sessions between the two hosts in the buffer and you'd like to see them all one by one, it is
recommended to start the reconstruction from the first session, as the back button (<<)
cannot navigate beyond the TCP session that was reconstructed first.
 
The obtained data can be saved as binary data, HTML, text, or rich text file by clicking File
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=>Save As… . When saving in text format, the resulting file is a Unicode UTF-16 file. When
saving in HTML format, the encoding of the resulting file depends on the currently selected 
Display type. If HTML is currently selected, the resulting file is an ANSI text file; for all
other display types the resulting file is a Unicode UTF-16 file. Note that if you're saving an
HTTP session with images, the images in the saved HTML file are stored in the temporary
location on your hard drive, so if you want to preserve them, open the saved file in your
browser and re-save the file in a format that includes images, such as MHT, before closing
BAS-o-matic.
 
You can search for a string in the session by clicking Edit => Find… .
 
Session Analysis
 
The Session Analysis tab of the TCP Session window graphically displays the reconstructed
TCP session. You can see the session data flow, errors, delays, and retransmissions of lost
data.
 
The following data is displayed for every session packet:
 

TCP flags.
Absolute and relative SEQ and ACK values.
Packet arrival time.
Delta time between the current and previous packet.
Packet number in the reconstructed session.

 
If a packet contains errors, the nature of the error is explained. It appears as a text
description along the right edge of the graph. When you move the mouse over a packet, its
contents are displayed in a hint window if the packet contains any data. Note that the 
Display type field affects the way the data is decoded in the hint window. A sample
session analysis window is shown below:
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The right pane shows some basic statistics for the given session:
 
Connection Time - the time it took to establish the TCP connection. In other words, it's
the three-way TCP handshake time (SYN => SYN ACK => ACK).
 
Server Response Time - the time elapsed between the initial client request and the
server's first data response.
 
Data Transfer Time - the time between the server's first and final data responses (0 if
there was only one server response).
 
You can save the graphic layout of the reconstructed TCP session as a BMP, GIF, or PNG
file by right clicking on the layout and selecting the Save Image As… menu item of the
context menu. Sessions with a large number of packets will be split into multiple files.
 

Statistics and Reports

Statistics and Reports

This window (View => Statistics) displays vital network statistics of your PC or LAN
segment, such as packets per second rate, bytes per second rate, Ethernet protocols, IP
protocols and sub-protocols distribution graphs. You can copy any of the graphs to the
clipboard by double-clicking on the graph. Ethernet protocols, IP protocols and sub-
protocols "pie" graphs can be rotated using the small buttons in the lower right corner for
better visibility of the slices.
 
The data displayed on each page can be saved as a bitmap or comma-delimited text file
using the context menu or drag-and-drop. The Report page allows you to have BAS-o-
matic automatically generate customizable reports in HTML or comma-delimited text
formats.
 
Network statistics can be collected either by using all the data that passes through your
network adapter or by using the rules that are currently set. If you want the statistics
counters to process only the data (packets) that match the current rule set and ignore all
other data, you should check the Apply current rules box.
 
General
Displays Packets per second and Bytes/Bits per second histograms, a bandwidth utilization
gauge (traffic per second divided by the NIC or modem link speed), as well as the overall
packet and byte counters. Double-clicking on the gauge brings up a dialog window that
allows you to manually configure the adapter speed to be used in the bandwidth utilization
calculations.
 
Protocols
Displays the distribution of the Ethernet protocols, such as ARP, IP, SNAP, SPX, etc. Use
the Chart by drop-down list to select one of the two available calculation methods: by
number of packets or by number of bytes.
 
IP Protocols
Displays the distribution of the IP protocols. Use the Chart by drop-down list to select one
of the two available calculation methods: by number of packets or by number of bytes.
 
IP Sub-protocols
Displays the distribution of the main IP application-level sub-protocols: HTTP, FTP, POP3,
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SMTP, Telnet, NNTP, NetBIOS, HTTPS, and DNS. To add more protocols, click on the 
Customize button. This dialog allows you to define up to 8 custom protocols. You should
enter a protocol name, select the IP protocol type (TCP/UDP), and port number. Use the 
Chart by drop-down list to select one of the two available calculation methods: by number
of packets or by number of bytes.
 
Sizes
Displays the packet size distribution chart.
 
Hosts by MAC
Lists active LAN hosts by MAC address and displays data transfer statistics. You can assign
aliases to MAC addresses. If you have too many multicast packets on your network and the
Hosts by MAC table is overpopulated, you may want to group multicast addresses to one
line that will be named GroupedMulticast. You can enable this function by checking the 
Group multicast addresses box.  Please note that only the packets that arrived after this
option has been set will be grouped accordingly; the previously received packets will not be
affected by this option.
 
Hosts by IP
Lists active LAN hosts by IP address and displays data transfer statistics. Since IP packets
captured by the program can be originated from an unlimited number of IP addresses (both
internal to your LAN and external), by default this tab doesn't display any statistics. To
have the statistics displayed, you should first set the range of IP addresses to be monitored
by clicking Add/Set Ranges. Normally, these ranges should belong to your LAN, and
configuring the program to monitor a certain range of IP addresses allows you to have the
usage statistics. You can enter any number of ranges, but the total number of IP addresses
being monitored cannot exceed 1,000. To delete a range, right-click on the list of ranges
and select the appropriate menu command. You can assign aliases to IP addresses.
Additionally, you can check the All box to have the program list all IP addresses; however,
this option is not recommended for RAM and CPU utilization reasons.
 
Matrix by MAC
This page displays the graphical conversation matrix between hosts based on their MAC
addresses. The hosts represented by their MAC addresses are placed on the circle, and the
sessions between them are shown as lines that connect the hosts. Moving the mouse over
a host highlights all connections that this host makes with other hosts. You can change the
number of the most active host pairs that are displayed in the matrix by changing the value
in the Most active pairs field. To change the number of the latest address pairs examined
by the program, modify the value in the Latest pairs to count field. If your network
segment has many broadcast or multicast packets that overpopulate the matrix, you can
ignore such packets by checking the Ignore broadcasts and Ignore multicasts boxes.
 
Matrix by IP
This page displays the graphical conversation matrix between hosts based on their IP
addresses. The hosts represented by their IP addresses are placed on the circle, and the
sessions between them are shown as lines that connect the hosts. Moving the mouse over
a host highlights all connections that this host makes with other hosts. You can change the
number of the most active host pairs that are displayed in the matrix by changing the value
in the Most active pairs field. To change the number of latest address pairs examined by
the program, modify the value in the Latest pairs to count field. If your network segment
has many broadcast or multicast packets that overpopulate the matrix, you can ignore such
packets by checking the Ignore broadcasts and Ignore multicasts boxes.
 
Errors
Displays the information on the Ethernet errors obtained directly from the adapter. Below
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are the explanations of the error types:
 
Rx CRS Errors
The number of frames received with circular redundancy check (CRC) or frame check
sequence (FCS) error.
Rx Alignment Errors
The number of frames received with alignment errors.
Rx Overrun
The number of frames not received due to overrun errors on the NIC.
Tx One Collision
The number of frames successfully transmitted after exactly one collision.
Tx More Collisions
The number of frames successfully transmitted after more than one collision.
Tx Deferred
The number of frames successfully transmitted after the NIC defers transmission at least
once.
Tx Max Collisions
The number of frames not transmitted due to excessive collisions.
Tx Underrun
The number of frames not transmitted due to underrun errors on the NIC.
Tx Heartbeat Failure
The number of frames successfully transmitted without detection of the collision-detect
heartbeat.
Tx Times CRS Lost
The number of times the CRS signal has been lost during packet transmission.
Tx Late Collisions
The number of collisions detected after the normal window.
Rx Frames w/Errors
The number of frames that a NIC receives but does not indicate to the protocols due to
errors.
Rx Frames w/o Errors
The number of frames that the NIC receives without errors and indicates to bound
protocols.
Tx Frames w/Errors
The number of frames that a NIC fails to transmit.
Tx Frames w/o Errors
The number of frames that are transmitted without errors.
 
Please note that:

Dial-up adapters are not supported, only hardware Ethernet cards.
Your adapter may not support all the listed fields. Some vendors make NICs that
provide all the required information, others don't.
Unlike other data in the Statistics window, the data on the Errors tab cannot be
reset when you click the Reset button. The counter is initialized when your
computer boots up.

 
Report
This tab allows you to have BAS-o-matic automatically generate customizable reports in
HTML (including images of charts and graphs) or comma-delimited text formats.
 
It is possible to have the program generate statistics on pre-captured data in addition to
real-time statistics. To do that, load a capture file in Log Viewer and click File =>
Generate Statistic. You can optionally reset previously collected statistics displayed in
the Statistics window. Please note that this function will not show packet distribution along
the timeline. It is limited to displaying totals, protocol charts, and LAN hosts tables.
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Using Aliases

Using Aliases

Aliases are easy-to-remember human-readable names that BAS-o-matic will substitute for a
MAC or IP address when showing the packets on the Packets and Statistics tabs. This can
make packets easier to recognize and analyze.  For example, 00:00:19:2D:0D:35 becomes
GATEWAY2, and ns1.earthlink.com becomes MyDNS.
 
To add a MAC alias right-click on a packet and select Create Alias Using Source MAC or
Using Destination MAC from the pop-up menu. A window will pop up where the MAC
address field is already filled out, and you will only need to type in an alias. Alternatively,
you can click Settings => MAC Aliases ... and fill out the MAC address and Alias fields
manually. To delete an alias or clear the entire aliases list, right-click on the Aliases window
and select Delete Record or Clear All. The same applies to creating IP aliases. When a
new IP alias is created by right-clicking on a packet, the alias field is pre-filled with the
corresponding hostname (if available) and can be then edited by the user.
 

Packet Generator

Packet Generator

This tool allows you to edit and send packets via your network card. To open the Packet
Generator, click Tools => Packet Generator, or select a packet from the Packets tab,
right-click on it, and select the Send Packet command.
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Please note that the Packet Generator cannot and should not be used for sending
application-layer TCP streams, i.e. it cannot take care of incrementing SEQ or ACK values
automatically, adjusting checksums and packet sizes and so forth. If you need to send a
TCP stream, you should use a Winsock-based application specifically designed for that
purpose. The Packet Generator is a tool for replaying pre-captured data, testing firewalls
and intrusion detection systems, as well as for performing other specific tasks that require
manual packet crafting.
 
The Packet Generator allows you to change the packet contents and have the packet
decode displayed in the left window as you edit it. You can create packets of any kind; you
have full control over the packet contents. For IP, TCP, UDP, and ICMP packets, you can
automatically correct the checksum(s) by clicking on the Sigma button. To assist you with
packet editing, the Visual Packet Builder tool is also available. It can be invoked by
clicking on the leftmost Plug button.
 
You can also click on the button with an arrow on it to display the list of available packet
templates. The program comes with TCP, UDP, and ICMP packet templates; using them is
often faster than typing hex codes in the editor window. These templates contain typical
TCP, UDP, and ICMP packets, but you would most probably want to edit many packet fields
and use meaningful values that suit your needs, such as real MAC and IP addresses, port
numbers, SEQ and ACK numbers, etc. You can use your own templates rather than the
built-in ones. You can drag-and-drop a packet from the BAS-o-matic Packets tab to the
Templates section in the Packet Generator window. If you drop several packets into the
Templates section, only the first packet will be used as a template. An entry named New
Template will appear in the list of templates. You can rename a template by right-clicking on
it in the list and selecting Rename. If you need to delete a template, right-click on it and
select Delete from the pop-up menu. Selecting a template in the list will load the packet
that it contains in the editor window where it can be edited prior to sending.
 
You can also place NCF files with the templates of your choice to the TEMPLATES subfolder
in the application folder. If BAS-o-matic finds NCF files (or just one of them) in the
TEMPLATES subfolder, it will list them among the available templates in the drop-down list.
These NCF files should contain only one packet per file, but if you use a file that contains
many packets, BAS-o-matic will load only the first one.
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Once you have edited a packet, use the controls below to send it:
 
Packet Size – modifies the packet size.
Packets Per Second – controls the speed at which packets will be sent. Be sure not to
send packets too fast if you have a slow connection. For example, sending a 1,000 byte
packet 5,000 times per second is more than your 10Mbit NIC can handle.
Continuously – select this option if you want the Packet Generator to send packets
continuously until you click Stop.
Time(s) – select this option if you want the Packet Generator to send packet a given
number of times.
Send/Stop – click this button when you are ready to send packets or to stop sending
them.
 
Working with multiple packets
 
You can use the Packet Generator to send multiple packets at once. To do that, just select
the packets you want to send in the list and invoke the Packet Generator using the right-
click menu, or drag and drop the selected packets to the Packet Generator window.
Alternatively, you can drag and drop capture files in all supported formats directly to the
Packet Generator window. When multiple packets are being sent, the packer editor and
decoder tree become invisible.
 
Saving edited packets
 
If you edit a packet and would like to save it, just drag the decoder tree to the desktop or
any folder, and a new file in NCF format containing the packet will be created. The file name
is always PACKET.NCF. You can also drag the packet to the templates window. If you need
to edit and send multiple packets, edit them one by one, each time dragging a new packet
to the desktop and renaming it. After that, open a new Log Viewer window, drag-n-drop the
edited packets from the desktop to Log Viewer, select them using the Shift button, and
invoke the Packet Generator using the context menu.
 
WARNING:
 

1. Don't use the Packet Generator unless you know exactly what effect you want to
achieve. Sending packets may produce unpredictable results, and we strongly
recommend refraining from using this tool unless you are an experienced network
administrator.

2. There should be at least one working computer on your LAN besides your own
computer when you use this tool. Otherwise, you will experience severe delays in
sending packets.

Visual Packet Builder

Visual Packet Builder is a tool designed for facilitating packet editing and generation in the 
Packet Generator. This tool allows you to quickly and correctly create a new packet or
modify an existing one using ready-made templates. Once created or edited, a packet can
be injected into the network using the Packet Generator.
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Standard TCP, UDP, and ICMP (based on the 4th and 6th versions of IP protocol), and ARP
packet generation is supported. To create a packet, select its type from the Packet Type
drop-down list. The default values of the packet fields will be automatically filled in, but can
be changed afterwards.
 
ICMP, TCP, UDP, and ARP packets consist of several encapsulated layers, and the interface
of Visual Packet Builder is arranged the same way. Options that correspond to the same
layer are located on a separate panel. For example, a TCP packet consists of 4 layers; the 
Source MAC and Destination MAC address fields are located on the Ethernet II panel
(Data link layer), and Src Port and Dst Port values are located on the TCP panel (Transport
layer). If you'd like to hide a panel, click the Expand/Collapse button located in the right
corner of the panel header.
 
Note that some "parental" layer values affect the packet type on lower layers; hence
modifying upper layers may lead to rebuilding the lower layers of a packet. Therefore, if you
change the Protocol type in the Ethernet II panel (Data link layer), it will lead to rebuilding
the whole packet. Another peculiarity that you should keep in mind is that the values of
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some fields depend on the contents of other fields, as well as the data contents of the
lower layers. Such fields are: checksums and header lengths, and/or data of lower layers.
Visual Packet Builder calculates such values automatically. However, when creating non-
standard packets, you may want to specify different values manually by checking the 
Override default value box and specifying the desired values.
 
Note: Visual Builder helps you control the correctness of the packet being built by
highlighting the headers and fields with incorrect or non-standard values in red.
 
Despite the fact that Visual Packet Builder has internal support for TCP, UDP, ICMP and ARP
protocols only, you can still use it to edit packets that use other protocols. For such
packets, you can use the hex editor to modify the data.
 
Once created, a packet can be saved and subsequently loaded to Visual Packet Builder
again. Use the respective commands located in the File menu of Visual Packet Builder for
loading/saving capture files. You can load any BAS-o-matic capture file (NCF); however, if
the file contains more than one packet, only the first one will be loaded.

NIC Vendor Identifier

NIC Vendor Identifier

The first 24 bits of a network card's MAC address uniquely identify the network card's
vendor. This 24-bit number is called the OUI ("Organizationally Unique Identifier").  The NIC
Vendor Identifier is a tool that allows you to look up a vendor name by MAC address. To
look up a vendor name, click Tools =>NIC Vendor Identifier, enter a MAC address, and
click Find. The vendor's name will be displayed.  By default, BAS-o-matic replaces the first
three octets of the MAC address by the adapter vendor name in the Packets tab. This
behavior may be changed by unchecking the Display vendor names in MAC addresses
checkbox in the General tab of the program Options dialog.
 

 
The list of vendors is contained in the MACS.TXT file located in the BAS-o-matic application
folder. You can manually edit this list to add/modify information.

Scheduler

Scheduler

You can use this tool to create and edit scheduled capturing tasks. This is useful when you
want BAS-o-matic to start and/or stop capturing when you're not around, for example, at
night or on weekends. To add a new task, click Tools => Scheduler, and then click on the
Add button.
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Use the Start capturing frame to specify the date and time when BAS-o-matic will start
capturing. Use the Adapter drop-down list to specify the adapter that should be used. Use
the Stop capturing frame to specify the date and time when BAS-o-matic will stop
capturing. You don't necessarily have to check both Start capturing and Stop capturing
boxes. If you check only the first box, capturing would go on until you manually stop it. If
you check only the second box, you'd have to start capturing manually, but then BAS-o-
matic would automatically stop capturing at the specified time.
 
If BAS-o-matic is already capturing packets at the time when the scheduled task is due and
if the adapter you specified is different from the adapter currently being monitored, BAS-o-
matic will stop capturing, switch to the adapter you specified, and restart capturing.
 
It is important to understand that the scheduled tasks can be performed only when BAS-o-
matic is running.

Capturing Loopback Traffic

Capturing Loopback Traffic

BAS-o-matic allows you to capture traffic on the loopback interface. To start monitoring
the loopback interface, select it from the drop-down list in the toolbar.
 
Loopback packets are the packets sent/received within the same computer, i.e. self-
addressed packets. Typically, there is virtually no loopback traffic on the standard PC.
However, loopback traffic is widely used by software developers for debugging network-
related applications. Therefore, BAS-o-matic's loopback capturing functionality is targeted
primarily at this user group.
 
When you capture loopback traffic, the packets look exactly as any other network packets,
except that the checksums are not computed. Please pay attention to the following
peculiarities when capturing loopback traffic:
 

BAS-o-matic captures loopback traffic on all of the local IP addresses. This always
includes 127.0.0.1/255.0.0.0, but may also include the IP addresses of your
Ethernet adapters, e.g. 192.168.0.1.
ICMP packets cannot be captured. Other IP protocols can (TCP, UDP, etc.).
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Only successfully sent/received packets are captured. For example, if a connection
attempt fails because the destination port is closed, you will not see any SYN / RST
packets.
Sessions are silently closed; no FIN packets are captured.

 

Setting Options

Setting Options

You can configure some of the program's options by selecting Settings => Options in the
menu.
 
General
 
Auto-start capturing – check this box if you want BAS-o-matic to start capturing packets
immediately after launching the program. For systems with multiple adapters, you should
also select the adapter to be used from the drop-down list.
 
Network
 
Disable DNS resolving – check this box if you don't want BAS-o-matic to perform reverse
DNS lookups of the IP addresses. If you check it, the Hostname column on the Latest IP
Connections tab will be blank.
 
Convert numeric port values to service names – check this box if you want BAS-o-
matic to display service names rather than numbers. For example, if this box is checked,
port 21 is shown as ftp, and port 23 as telnet. The program converts numeric values to
service names using the SERVICES file installed by Windows. You can find the SERVICES file
in the \system32\drivers\etc folder. You can edit this file manually if you want to add more
ports/service names.
 
Convert MAC addresses to aliases – substitute MAC addresses for aliases on the
Packets tab. Aliases[****]can be assigned to MAC addresses using the Settings =>MAC
Aliases menu command.
 
Convert IP addresses to aliases – substitute IP addresses for aliases on the Packets and
Statistics tabs. Aliases can be assigned to IP addresses using the Settings =>IP Aliases
menu command.
 
Convert IP addresses to hostnames in the "Packets" tab – check this box if you want
BAS-o-matic to show resolved hostnames rather than IP addresses in the Packets tab. If
this box is checked, BAS-o-matic will first attempt to find an alias for the given IP address.
If no alias is found or the previous box (Convert IP addresses to aliases) is not checked,
BAS-o-matic will query the internal DNS cache for the hostname. If no hostname is found,
the IP address will be displayed in numeric form.
 
Display vendor names in the MAC addresses – by default, BAS-o-matic replaces the first
three octets of the MAC address by the adapter vendor name on the Packets tab. Uncheck
this checkbox if you want to change this behavior.
 
Use non-promiscuous mode – by default, BAS-o-matic puts the network adapter in
promiscuous mode, which means that the program captures all traffic in the local LAN
segment. Checking this box switches BAS-o-matic to non-promiscuous mode, which you
sometimes may want to use, e.g. if your company's IT policy doesn't allow promiscuous
packet monitoring, or to reduce CPU usage in the situation where you're interested only in
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your own inbound and outbound packets and have to filter out many pass-through packets.
 
Notify when the adapter list has changed – check this box if you want BAS-o-matic to
display a balloon message in the system tray area once the number of active network
adapters has been changed.
 
Display full process path – check this box if you want to see the full path to the process
sending/receiving packets in the Latest IP connections tab, as well as in the decoded
packets tree in the Packets tab (e.g. "C:\Files\Program.exe" is a full path, whereas
"Program.exe" is a short path).
 
Display friendly adapter names – checking this option will make BAS-o-matic display the
adapter names in the adapter selection drop-down list in the tool bar as they appear in the
Windows Network Connections page.
 
Show gridlines – makes the program draw gridlines in all packet lists.
 
Memory Usage
 
Display
 
Maximum packets in buffer – sets the maximum number of packets the program stores in

the memory and can display in the packet list (2nd tab). For example, if you set this value
to 3000, only the last 3000 packets will be stored in the memory and packet list. The higher
this value is, the more computer resources the program consumes.
 
Note that if you want to have access to a high number of packets, it is recommended that
you use the auto-saving features (see Logging for more information): it allows you to dump
all the packets to a log file on the hard drive.
 
Maximum lines in Latest IP Connections - sets the number of lines the program displays
on the Latest IP Connections tab. When the number of connections exceeds the limit, the
connections that have been idle for the longest period of time are removed from the list.
 
Driver Buffer - sets the driver buffer size. This setting affects the program's performance:
the more memory allocated for the driver buffer, the fewer packets the program drops. For
low traffic LANs and dial-up connections, the buffer size is not critical. For high traffic LANs,
you may want to increase the buffer size if the program drops packets. To check the
number of dropped packets, use the File => Performance Data menu command while
capturing is on.
 
Latest IP Connections
 
Display Logic – allows you to select the Latest IP Connections layout that best suits your
needs. Selecting an item from the drop-down list will display the description of the selected
logic. In most cases, it is recommended to use the default Smart logic.
 
Define Local IP Addresses – you should use this tool if you monitor LAN traffic with many
pass-through packets and a mixture of external and internal IP addresses. In such a
situation BAS-o-matic doesn't "know" which IP addresses should be treated as local and
might reverse the IP addresses in the Local and Remote IP columns. This tool allows you to
define the local network addresses and subnet masks to make sure the Latest IP
Connections window works correctly. This will work only if you use the default Smart logic.
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Add numeric PID to process names – check this box if you'd like the process ID (PID)
shown next to the process name in the Process column.
 
Colors
 
Packet color – sets the color for displaying packets on the Packets tab based on the
packet direction (in, out, pass-through). To change a color, select the packet direction
from the drop-down list and click on the colored rectangular.
 
Colorize Packet Headers – check this box if you want BAS-o-matic to colorize packet
contents. If this box is checked, the program displays the first eight packet layers using
different colors.  To change a color, select the type of header for which you want to
change the color and click on the colored rectangular.
 
Formula syntax highlighting – sets the colors for highlighting keywords in formulas in the
Advanced Rules window.
 
Selected byte sequence color – sets the font and background color for displaying the
byte sequence that was selected in the decoder tree. For example, when you select the
"TCP" tree node, the corresponding part of the packet will be highlighted using these colors.
 
Decoding
 
Always fully expand all nodes in the decoder window – check this box if you would like
to have all nodes in the decoder windows automatically expanded when you select a new
packet in the packet list.
 
Expand the last nodes – check this box if you would like to have the last node(s) in the
decoder window automatically expanded when you select a new packet in the packet list
and set the number of nodes to be expanded. By default, the first node is expanded. This
setting has no effect if the Always fully expand all nodes in the decoder window box is
checked.
 
Decode up to the first level only in ASCII export – this option affects the decoding
format used when you export a packet log or individual packet as ASCII file with decode. If
this box is checked, only the top-level nodes will be saved. For example, if you save a TCP/
IP packet when this option is disabled, all T ype of serv ic e sub-nodes are saved. When this
option is enabled, these sub-nodes are not saved. Checking this box makes the output
ASCII file less detailed and more compact.
 
Ignore incorrect checksums when reconstructing TCP sessions – this option affects
the way BAS-o-matic treats malformed TCP/IP packets when reconstructing TCP sessions.
By default, this option is on, and packets with incorrect checksums are not discarded in the
process of reconstruction. If you turn off this option, packet with incorrect checksums will
be discarded and not displayed in the TCP reconstruction window. Attention Gigabit card
users: all your outbound packets will have incorrect checksums if the "checksum offload"
feature is present. If you turn off this option, it's likely that you will see only half of the
reconstructed TCP stream. The same applies to reconstructing loopback sessions, as
loopback packets have zero checksums.
 
Include packet numbers when reconstructing TCP sessions – check this box if you'd
like the chunks of data shown in the TCP session reconstruction window to be prepended by
the packet numbers that correspond to these chunks of data.
 
Search for the session start when reconstructing TCP sessions  if this box is checked,
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the program will attempt to find the beginning of the TCP session when you reconstruct it.
If it is not checked, the session will be reconstructed only from the selected packet, i.e.
earlier packets will be discarded.
 
Decompress GZIP content – check this box if you want BAS-o-matic to convert GZIP-
compressed HTTP content into readable text in the TCP Session Reconstruction windows.
GZIP content is decompressed only when the display type in the window is set to "ASCII".
 
Reconstruct images – check this box if you want BAS-o-matic to convert binary HTTP
streams that represent images into viewable JPG, BMP, PNG, and GIF pictures in the TCP
Session Reconstruction windows. Images are shown only when the display type in the
window is set to "HTML". Images are never shown within the HTML pages to which they
belong, as they are transferred by the server in a separate HTTP session.
 
Use IPv4-style endings in IPv6 addresses – if this box is not checked, IPv6 addresses
are shown using hexadecimal symbols only, e.g. fe80::02c0:26ff:fe2d:edb5. If this box is
checked, the last 4 bytes of IPv6 addresses are shown using the IPv4-style dotted
notation, e.g. fe80::02c0:26ff:254.45.237.181.
 
Reassemble fragmented IP packets – check this box if you'd like the program to
reassemble IP packets that are fragmented. By default, fragmented IP packets are displayed
as they were received from the wire, in their original form. If this option is turned on, the
program will maintain an internal buffer of fragments and will attempt to "glue" them,
displaying only the results of successful reassembly.
 
Attempt to map incoming UDP packets to processes – by default, the program's
packet-to-application mapping system does not try to map incoming UDP packets to an
owning process due to the  probabilistic nature of such mapping. Check this box if you'd like
the program to attempt to map these packets.
 
Default display type – select the display type value from the drop-down list that you want
to set as default for TCP Session Reconstruction function. The available values are ASCII,
HEX, HTML, and EBCDIC.
 
Geolocation
 
Geolocation is IP-to-country mapping for IP addresses. When this functionality is enabled,
BAS-o-matic checks the internal database to provide information on the country any IP
address belongs to. You can configure the program to show ISO country code, Country
name, or Country flag next to any IP address. You can also disable geolocation. For some
IP addresses, such as reserved ones (e.g. 192.168.*.* or 10.*.*.*) no information on the
country can be provided. In such cases, the country name is not shown, or if you use the 
Country flag option, a flag with a question mark is displayed.
 
As IP allocation is constantly changing, it's important that you always have an up-to-date
version of BAS-o-matic. A fresh, up-to-date database is included in every BAS-o-matic
build. A fresh database has 98% accuracy. Without updates, the accuracy percentage falls
by approximately 15% every year.
 
Miscellaneous
 
Hide from the taskbar on minimization - check this box if you don't want to see the
program's button on the Windows taskbar when you minimize the program. If this box is
checked, use the program's system tray icon to restore it after minimization.
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Allow multiple application instances – check this box if you would like have multiple BAS-
o-matic instances running simultaneously to be able to capture traffic going through
different adapters. This option is not available under Windows 95.
 
Prompt for confirmation when exiting the application – check this box if you would like
the program to ask you for a confirmation when you close it.
 
Auto-scroll packet data window - if this box is checked, the program scrolls the text of
the packet data window automatically when you select a new packet from the packets list
(but only if the text does not fit into the window). This is useful when you want to see the
contents of a long packet without manually scrolling the window.
 
Auto-scroll packet list to the last packet - if this box is checked, the program
automatically scrolls the packet list in the Packets tab down to the last received packet.
 
Auto-sort new records in Latest IP Connections - if this box is checked, the program
auto-sorts new records on the Latest IP Connections tab based on the user-defined sorting
criterion  (e.g. ascending order of remote IP addresses).
 
Smart CPU utilization control – if this box is checked, the program tries to decrease CPU
utilization when capturing high-volume traffic by decreasing the quality and frequency of
the screen updates.
 
Run on Windows startup - if this box is checked, the program is launched automatically
every time you start Windows. Under Windows Vista, checking this box will have no effect if
UAC is enabled. This is a limitation of Vista that prevents application with elevated rights
from loading on startup. If this feature is important, disable UAC.
 
Run minimized - if this box is checked, the program is launched minimized and the main
window is not displayed until you click on the tray icon or taskbar button.
 
 
Automation Protocols

This tab is used by Automation Protocols BAS-o-matic plug-ins which are purchased with
BAS-o-matic. Here you can configure the settings for your Automation protocols.

For more information go to Help - choose the name of an Automation protocol you want to
know how to configure: BACnet MS/TP, Modbus RTU, Modbus TCP, BACnet/IP & B/E.

Emailing a Log File

Emailing a Log File

Overview - Saving a capture session to a file is called "Logging". Please read this section in
this help file under Using BAS-o-matic | Logging . You can create a log file manually or
you can set BAS-o-matic to save data automatically (called Auto-save). Once you have a
log file, this can be viewed by selecting File | Log Viewer . From the Log Viewer you can
save the data file to the directory of your choice. Include this file as an attachment to an
email when you need to exchange this data file with others.

1) What to Save - Capturing packets for diagnostic purposes requires that you start the
data capture before the start of the suspected communications error. Also, it helps to
isolate the EXACT types of packets in question so you don't have to search through
unimportant information when trying to follow a communications sequence. To help isolate a
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problem use data filtering. Data filtering is done by adjusting the BAS-o-matic filter settings
so only specific packet types are saved. Refer to the Help chapter called BACnet - Setting
Filters for a quick tutorial, or Using BAS-o-matic | Filters & Rules and Using BAS-o-
matic | Advanced Rules for a more in-depth explanation of your filtering options.

2) Set the size of your Log File - Before you start you capture, adjust the file size under
Logging | Maximum Directory Size . There are times where you might want to save a lot
of data for review, but if you are planning on emailing you should set this to the lowest
value (1 MByte).

3) How to Save - The captured files can be saved by going to the menu Logging and then
check Auto Saving . Use the Save logs to: selection to designate a directory where the
log file should be stored. When you start your capture, data will be sent to a default file in
your designated directory each time 500 packets have been received. Files can also be
saved by using the option File | Save Packet Log as and choosing the desired extension
type.

Files can be saved to log files in several formats:

- BAS-o-matic Capture Files (*.ncf)  
- NI Observer files (*.bfr)   
- NAI Sniffer files (*.enc)  
- Text Files (*.txt)   
- Comma delimited files (*.csv)  
- Comma delimited files with HEX data (*.
csv) 

 

- Binary Files (*.bin)  
- Wireshark/TCPdump files(*.cap)  
- MS NetMon files (*.cap)  
- NAI Sniffer for Windows files (*.cap)   
- EtherPeek files (*.pkt)  
- AiroPeek files (*.apc)  

4) How to view your data - Select File | Log Viewer and then File | Load BAS-o-matic
Logs… to select the Log file that you just captured.

5) Emailing your Log file - Send this file as an attachment to your text message. For
example, in Outlook Express select Create Mail then Insert | File Attachment and then
find the file in the directory that you stored the log file in (default = …/BAS-o-matic/logs
directory).

Frequently Asked Questions

Frequently Asked Questions

Q. What exactly does BAS-o-matic "see" when installed on a PC connected to a LAN?
A. BAS-o-matic enables the network card's promiscuous mode and can capture network
traffic on the local segment of the LAN. In other words, normally it captures and analyzes
packets addressed to all of the computers on the segment, not only to the one where the
program is running. There are certain limitations for Wireless Ethernet adapters (you can
monitor only inbound/outbound traffic) and switched networks (see the next question about
switches in this FAQ).

Q. I am connected to the LAN through a switch, and when I launch BAS-o-matic, it
captures only the packets sent to and from my machine. I can't see the traffic of



45Chapter 2 Using BAS-o-matic features

2Using BAS-o-matic features

other machines. Why is this so?
A. Unlike hubs, switches prevent promiscuous sniffing. In a switched network environment,
BAS-o-matic (or any other packet analyzer) is limited to capturing broadcast and multicast
packets and the traffic sent or received by the PC on which BAS-o-matic is running.
However, most modern switches support "port mirroring", which is a feature that allows you
to configure the switch to redirect the traffic that occurs on some or all ports to a
designated monitoring port on the switch. By using this feature, you will able to monitor the
entire LAN segment. Please refer to the documentation that comes with your switch for
information on availability of this feature and configuration instructions. Various networking
hardware manufacturers name this feature differently. Below is a short reference list of
hardware by three major manufacturers – Cisco, 3COM, and Intel that support port
mirroring.

Manufacturer Name used for the port
mirroring feature

Models of switches with port
mirroring support

Cisco Switched Port Analyzer (SPAN) Cisco Catalyst 1900 Series Switches
Cisco Catalyst 4500 Family Switches
Cisco Catalyst 6000 Family Switches

3COM Roving analysis port (RAP) 3Com SuperStack 3 Switch 4400

Intel Port mirroring Intel Express 460T
Intel Express 480T

Q. Ok, I am connected to the LAN through a hub, but I can't see other machines'
traffic again, as if it's a switch. Why is this so?
A. There are two possible reasons: Either you have a hub that is only labeled as a hub, but
inside is a switch (some vendors like Linksys do that), or you have a multi-speed hub, in
which case you can't see the traffic from the stations operating at the speed that is
different from your NIC's speed (e.g. if you have a 10 Mbit NIC, you can't see the traffic
generated by 100 Mbit NICs).

Q. I have a home LAN connected to the Internet via a broadband router, and I can
see only my own traffic. Is it possible to capture the traffic of other machines on my
home LAN?
A. Yes. A typical home network configuration is shown below:
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Since your router works as a switch, a computer on your LAN can see only its own traffic
(and broadcasts from the other computers). However, there is a workaround. You can put a
hub between the router and the Internet. Then, install the second NIC into your PC, and
connect that NIC to this hub. The second NIC doesn't have to be bound to any protocol or
even have an IP address. It would be totally passive, for monitoring purposes only. You can
then use BAS-o-matic to capture data from the second NIC. This configuration is illustrated
below.

Be sure to install a real hub, because some hubs are only labeled as hubs, but inside are
switches (some vendors like Linksys do that). Obtain a cheap, bare-bones hub. An old,
second-hand one will do.

Q. Can BAS-o-matic capture data from a network adapter that doesn't have an IP
address?
A. Yes. In fact, the network adapter does not need to be bound to TCP/IP or any other
protocol. In a situation where you are troubleshooting a network it might be necessary to be
able to plug in the computer running BAS-o-matic into an available port on a hub. In such
cases you do not need to guess the IP address available in the LAN segment, all you need
to do is unbind the network adapter from TCP/IP and start capturing. In Windows 2000/
XP/2003 open Control Panel => Network Connections, right-click on the connection icon,
select Properties, and uncheck the boxes corresponding to the protocols you don't want to
be bound to the NIC. In Windows 9x Control Panel => Network, select the TCP/IP => Your
NIC item, click Remove, and then reboot.

Q. I launched the program and clicked "Start Capture", but no packets are displayed.
Why?
A. There are two possible reasons: You either selected an unused network adapter, or you
made a mistake when configuring the capturing rules. Turn off the rules and see what
happens. In any case, even when the capturing rules are on, the program's status bar
should display the total number of packets, so have a look at it before panicking.

Q. I noticed that IP/TCP/UDP checksums in the outgoing packets are incorrect. Why
is it so?
A. New Gigabit network adapters have a feature called TCP/UDP/IP "checksum offload",
which allows the network adapter to calculate packet checksums, thus increasing the
system performance and decreasing CPU utilization. Since BAS-o-matic intercepts packets
before they reach the network adapter, the checksum appears to be incorrect. This is
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normal and the only thing that it might affect is the reconstruction of TCP sessions and only
if you changed the default "Ignore incorrect checksums" option.

Q. My network connection is via a cable/xDSL modem. Will BAS-o-matic be able to
monitor traffic on it?
A. If your modem has a dual USB/Ethernet interface and you can connect it to an Ethernet
card, BAS-o-matic will certainly capture traffic on it. If it has only a USB interface, the best
thing to do is to try.

Q. My firewall software warns me that BAS-o-matic is "attempting to access the
Internet." I am aware that some sites are able to track users by collecting the
information sent by their programs via Internet. Why does BAS-o-matic "attempt to
access the Internet"?
A. What alerts your firewall is the attempt to resolve IP addresses to hostnames. Since
BAS-o-matic has to contact your DNS servers to make a DNS query, it inevitably triggers
the alarm. You can disable this feature (Settings => Options => Disable DNS resolving), but
in this case, the Latest IP Connections tab will not be able to show you the hostnames. DNS
queries are the only type of connection BAS-o-matic can potentially make. There are no
other hidden activities. We don't sell spyware.

Q. I'm often logged on as a user without administrative privileges. Do I have to log
off and then re-logon as the administrator to be able to run BAS-o-matic?
A. No, you can open BAS-o-matic folder, right-click on the CV.exe file while holding down
the Shift key, and select "Run As" from the pop-up menu. Enter the administrative login and
password in the window that pops up and click OK to run the program.

Q. Can I change PC cards on my notebook while BAS-o-matic is running?
A. No, it's safer to close BAS-o-matic, then change or plug/unplug your card, and restart
the program. The adapter list will be automatically updated.

Q. I'm on the LAN with high traffic volume, and I noticed that BAS-o-matic increases
the CPU load and/or becomes less responsive. What can I do about it?
A. The best way to optimize the program's performance is to use rules to filter out the
packets you don't need to monitor. For example, sending a 50 MB file between two machines
on your LAN can generate approximately 40,000 NetBIOS packets with the data transfer
rate of 10 MBytes per second, which can be a heavy load for the application. But normally
you don't to need to view every NetBIOS packet being sent, so you can configure BAS-o-
matic to capture IP packets only. BAS-o-matic has a flexible system of filters, and you can
fine-tune the application to display only the packets that you really need. If you are
interested in the statistics information only (those green histograms, pie charts, and hosts
tables), you can use the "Suspend packet output" menu command, which allows you to
have statistical data without real-time packet display.

Links to Networking Resources

Links to Networking Resources

Here are some other resources where you can learn more about relevant issues.
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NOTE: Check the protocol specific help files for more links.

Building Automation

AutomatedBuildings.com - A fascinating array of articles, interviews, products, and more...

Engineered Systems Magazine - Industry news, relevant installation articles, and more...

Sensors Magazine - Interesting news and articles about the use of Ethernet and BACnet in
building automation systems.

HPAC Magazine - Excellent articles about the building automation sector.

Ethernet Information

TechFest Ethernet Tutorial - Good analysis of packets and a glossary.

About.com - TCP/IP Addressing and Subnetting - A great resource for reminding you about all of
those subnetting details.

Troubleshooting & General Information

Packetlevel.com - Books and articles about packet level troubleshooting.

Protocols.com - There are a lot of issues here that are not relevant (for example, wireless and
ATM protocols), but the TCP/IP section has a lot of good information.

Network World Fusion - A networking portal with a huge amount of networking information.

Microsoft Certified Professional Magazine - Microsoft's magazine with a wealth of network
training information.

Cisco.com Glossary of Terms and Acronyms - Get a definition of all of those acronyms and geek-
speak concepts.

License Terms and Conditions

License Terms and Conditions

Please read the following terms and conditions carefully before using this software. Your use
of this software indicates your acceptance of this license agreement. If you do not agree
with the terms of this license, you must remove this software from your computer and stop
using this product.

Copyright
This software is copyrighted 1999-2012 by TamoSoft, Inc. and copyrighted 2012 by
Cimetrics, Inc. BAS-o-matic is a trademark of Cimetrics, Inc.. The use and copyright of this
software is governed by international copyright treaties. TamoSoft and Cimetrics retain full
title and rights to this software and documentation, and in no way does the license granted
diminish their intellectual property rights. You must not redistribute the registration codes
provided--on paper, electronically, or in any other form.

Evaluation Version
This is not free software. You are hereby licensed to use this software for evaluation
purposes without charge for a period of 30 days. Using this software after the evaluation
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period violates copyright laws and may result in severe civil and criminal penalties.

Registered (Licensed) Version
This program requires either a hardware protection key ("dongle") or a software key which
means that only one registered copy may be used on one computer.

Disclaimer
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
TAMOSOFT, INC. OR CIMETRICS, INC. BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING
INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS LICENSE, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS.

Governing Law
This Agreement will be governed by the laws of the state of Massachusetts, USA.

Distribution
The evaluation version of this software may only be obtained from Cimetrics, Inc or their
authorized agents.

Other Restrictions
You may not modify, reverse engineer, decompile, or disassemble this software in any way,
including changing or removing any messages or windows.

Windows is a registered trademark of Microsoft Corporation. All other trademarks and service
marks are the property of their respective owners.

Cimetrics Software Products

Cimetrics Software Products

We have other Automation Tools and Solutions that can help you with your next job.
Visit our website at www.cimetrics.com or send an email to info@cimetrics.com for further
details.

NOTE: Several of these programs have demo versions (upon request).

- BACnet OPC Server - Control BACnet devices with any OPC workstation.
- BACnet Explorer - Auto discovery of devices and status on existing BACnet networks.
- BACstac series - BACnet Windows and embedded protocol stacks for manufacturers.

BACnet OPC Server: Enables control and monitoring BACnet devices from any OPC
workstation.



50 Chapter 4 Cimetrics Information

4Cimetrics Information

go to top

BACnet Explorer: Connect to any BACnet network and automatically discover all BACnet
device settings.

 

go to top

BACstac series: Save design time and support costs by using the industry's leading OEM
BACnet protocol stack.
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Cimetrics Hardware Products

Cimetrics Hardware Products

We have many Building Connectivity solutions that can help you with your next job. Visit
our website at www.cimetrics.com or send an email to info@cimetrics.com for further
details.

- BR2-A Router Series - connect BACnet/IP and BACnet ARCNET together.
- BR2-E Router Series - connect BACnet/IP and BACnet Ethernet.
- E+ Protocol Interfaces - Inexpensive serial and I/O solutions.
- U+4 Protocol Interface - USB to RS485 coprocessor interface.
- BACnet to Microcontrollers Module - System on a chip for BACnet and EIA 709.

BR2 Router series: The BR2 router provides routing between BACnet networks such as
BACnet/IP, BACnet ARCNET, BACnet Ethernet, and virtual or tunneled BACnet networks. 
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E+ series: Inexpensive serial and I/O solutions. Models include BACnet/IP to BACnet Web
Services, Bacnet/IP/WS to Relays and DIN, BACnet/IP/WS to Home Automation, Modbus/
TCP to Modbus RTU, and many more. See our web site for the latest models (www.
cimetrics.com).

go to top

U+ series - Fieldbus Interface: USB to RS485 interface for BACnet MS/TP or Modbus RTU.

go to top
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BACnet to Microcontrollers Module: EasyBAC module is an elongated Ethernet connector
with a powerful built-in microprocessor and has all of the memory and software required to
support connection to a BACnet/IP network.

go to top

Contact Us - Support

Contact Us - Support

Our full contact information is:

Cimetrics Inc.

Tel: +1 (617) 350-7550 
Fax: +1 (617) 350-7552
Email: info@cimetrics.com 

For support, please contact:

support@cimetrics.com  

We would prefer email, but if you need to speak to someone immediately call:

+1-617-350-7550  

Thank you !

Demo - Ordering

Demo - Ordering

DEMO - If you want to try the demo or download the latest version, go to 
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http://www.cimetrics.com/index.php/b5020-bacnet-protocol-analyzer.html

ORDERING

Price quote: send an email to info@cimetrics.com or call 888-246-3874 or 617-350-7550

Order: please email purchase@cimetrics.com or fax a purchase order to 617-350-7552 with
the following information:

- The BAS-o-matic product you would like (select from the model numbers below)
   
- B5020 - BAS-o-matic Protocol Analyzer (includes BACnet/IP & BACnet/Ethernet)  
- B2110 - BACnet MS/TP decoder (includes U+4 hardware interface. Compatible with
32 and 64 bit systems)  
- B5022 - BAS-o-matic Protocol Analyzer (includes Modbus TCP)
- B5023 - Modbus RTU decoder (includes U+4 hardware interface. Compatible with 32
bit systems)  

- Your decoder license choice: 1. soft license (machine ID needed), 2. USB dongle 

- Your email address (where to send the license files to activate your software)

- Your billing and shipment information

Payment will need to be by credit card, bank deposit, or on account (credit verification
required). We will contact you to complete the payment process.

Thank you !
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